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Introduction 

This syllabus has been designed to guide trainers on how to conduct training on communicating 
gender data. The syllabus can also be used by learners who wish to know more about this topic and 
people who are generally interested in gender statistics.  

This syllabus is part of a wider module on this area of gender statistics. Other materials within this 
module may include exercises, sample data sets, Power Point presentations and example quizzes. 
Please refer to the additional set of materials for a comprehensive and effective learning experience.  

Who is this module for?  

- Statisticians and other experts who wish to understand how to create effective 
communication products with gender statistics  

- Policymakers and decision-makers who are looking to use gender data to generate more 
effective communication products 

- Academics and researchers who wish to enhance their communication skills to disseminate 
their gender data analysis 

- Civil society organizations that wish to enhance their use of gender data for advocacy or 
communication purposes 

- Media personnel interested in integrating gender data into their media products and who 
wish to communicate gender-sensitive data-driven stories to audiences 

- Anyone who wishes to find out how to use and communicate gender data effectively. 

While some sections are more directly targeted to producers (e.g. section 1) and others more to users 
(e.g. section 2.1), most are suitable for all learners and instructors are encouraged to cover the totality 
of the syllabus, while emphasizing knowledge on the sections most relevant to students’ needs.  

What do I need to know before going through this module?  

This module is targeted to both experts and non-experts on gender statistics. Data producers will 
benefit from this module as it will provide the necessary tools to generate effective gender data 
communication products. Data users can learn how to utilize existing data to convey messages 
effectively, or how to correctly interpret the data that are communicated to them. No advanced 
knowledge of statistics is necessary. However, it is strongly recommended that learners have 
completed modules 1, 2 and 9.  

Learning objectives 

The expected learning outcomes for this module include:  

- Understanding what gender data communication strategies are, and the different channels of 
communication that may be used. 

- Gaining basic knowledge of visualizing gender data using graphs, maps and other visual 
elements.  

- Learning how to customize gender data stories and visuals for different channels of 
communication and audiences.  

Note to trainer: Depending on the pace of the trainer and trainees, it is expected that training for this 
module can be delivered in 2-3 hours. 
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1. Communicating gender data 
Data dissemination is a phase in statistical processes in which data collected and compiled by statistical 

agencies are released to users1. Although this data may be made available to users, it may not always align 

with their needs or  be published in a format that is adequate to engage audiences, policymakers and 

journalists. As a result, available data is often underused. This issue, which essentially arises due to the 

lack of communication between data producers and users, leads to data waste.  

 

 

 

 

 

 

 

 

Data communication is different from data dissemination.  

- Data dissemination: is the public disclosure of statistics by any appropriate means, including 

through scientific publications in any medium. Dissemination provides direct access to the 

statistics, without consideration of users’ specific needs.2 

- Data communication: is the strategic outlining and delivery of key data-driven messages using 

relevant media formats and communications channels to best target identified audiences for the 

widest possible reach.  This planned process starts at the outset of the data production (e.g. 

communication between users and producers to identify needs) and continues throughout the 

entire data production and release processes, with the aim of promoting statistics and key 

messages, which can be used for influencing an overarching goal, outcome or desired action (e.g. 

awareness-raising, policy decisions, two-way exchanges or dialogues, etc.). It requires strategic 

and targeted measures for communicating with a multitude of audiences, including the media 

and the public3. Once the statistics are produced, they must be communicated to different 

audiences using the most relevant communication channels. 

Thus, communication takes different forms, from dialogue between data users and producers, to the 

preparation of infographics, to news media coverage. Communication, essentially, aims to align the supply 

of data with the demand for data. With better alignment, data waste is likely to be reduced significantly.  

 
1 See PARIS21 NSDS Guidelines https://nsdsguidelines.paris21.org/printpdf/node/796 
2 See: European Union https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-
E_0.pdf 
3 See: European Union https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-
E_0.pdf 

Data 

dissemination 

(based on 

availability) 

Data demand 

Figure 1: Lack of communication between users and producers leads to data waste 

https://nsdsguidelines.paris21.org/printpdf/node/796
https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-E_0.pdf
https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-E_0.pdf
https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-E_0.pdf
https://www.iprhelpdesk.eu/sites/default/files/EU-IPR-Brochure-Boosting-Impact-C-D-E_0.pdf


6 
 

 

 

 

1.1. Building a communication strategy for gender data   
Data producers often disseminate gender data, but rarely communicate it. For instance, data produced 

by statistical agencies are often released to the public through databases and survey reports. Although 

these might be sufficient to reach interested and expert users, including statisticians and in some cases 

policymakers interested in gender issues, these data are unlikely to reach other decision-makers, non-

statistical experts and the general public. Effective communication strategies can substantially increase 

the use of gender data, particularly among non-expert users.  

A communication strategy helps to define clear priorities, identify target audiences, create appropriate 

key messages and choose the right communication channels around an overarching goal4. Having a 

strategy can also help advocate for the importance of statistics5. Data communication strategies are key 

to reducing data waste (e.g. the amount of data produced that remains unused or rarely used) and help 

align the data produced with user’s needs. Data communication strategies must therefore take into 

consideration:  

- All potential types of data users, their skills and their interests (and target communication 

messages accordingly) 

 
4 See UNESCAP, Creating an Effective Communication Strategy https://www.unescap.org/sites/default/files/T3-
Guidebook.pdf 
5 See https://nsdsguidelines.paris21.org/node/278 

1. Dialogue between users 
and producers to identify 
data needs and desired 

formats

2. Data production 
following advice from (1)

3. Data analysis in 
coordination with users (to 

meet their needs)

4. Generation of reports, 
infographics, media 

products, web materials, 
etc. in line with user's needs

5. Communication of 
findings and dissemination 
of products using targeted 

channels for each user

Data 

dissemi

nation 
Communication  

Data 

demand 

Figure 2: The communication cycle can better align data needs and data availability 

https://www.unescap.org/sites/default/files/T3-Guidebook.pdf
https://www.unescap.org/sites/default/files/T3-Guidebook.pdf
https://nsdsguidelines.paris21.org/node/278
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- All possible forms of communication, from databases and publications to audiovisual content, 

infographics and social media materials. 

An effective data communication strategy should include specific actions to reach all potential types of 

data users through different communication channels. Thus, a data communication strategy should ideally 

comprise separate sections for different target audiences, as well as differentiated sections for different 

forms of communication and channels and formats. In some cases, data communication strategies might 

cover a combination of these two factors (e.g. communicating data to youth through the use of social 

media). 

 

 

Potential users Forms of communication Combinations 

Expert statisticians Databases  

Policymakers Survey reports Survey reports for expert 
statisticians 

Academics Visualizations for social media Youth-targeted visualizations, 
infographics, videos or blogs for 
social media 

Civil society Television content  

Youth Website  

General public Newsletter  

Private sector User-producer dialogues User-producer dialogues to 
engage civil society 

 

The design of gender data communication strategies must be informed by user-producer dialogues, which 

must happen at two stages:  

- Stage 1: Dialogue pre data production 

At this stage, data producers and data users must have an exchange to communicate their 

thoughts and ideas regarding data needs and availability. This should be an opportunity for data 

users to articulate their data needs and their level of skills to understand and utilize available data. 

This is also an opportunity to discuss preferred data formats and communication channels. Data 

producers can shed light on their capacity and any potential constraints to produce the data being 

demanded. 

- Stage 2: Dialogue post data production  

Once the relevant data have been produced, data producers must communicate it to users. One 

avenue for such communication is user-producer dialogue. This post-production dialogue would 

include sharing and explaining results to make the data accessible, keeping in mind their users’ 

level of expertise, along with sharing information regarding where to find the data, how to access 

it, how to interpret it, and where to find related metadata. In addition, such dialogues are useful 

for producers to tailor data dissemination products to user’s needs and specific events. These 

Figure 3: Examples of sections in a data communication strategy 
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dialogues are also useful for data users to understand calendars of data releases, and plan 

accordingly. 

Ideally, user-producer dialogues should be an institutionalized, strategically mapped out process, rather 

than a series of ad-hoc events. They should be scheduled to take place on a periodic basis. Besides helping 

with the design of communication strategies, such dialogues can provide key insights to enhance data use 

and reduce misinterpretation. For instance, if a large national conference is being held in a certain country 

to commemorate the national HIV prevention day, user-producer dialogues might provide an opportunity 

for data users to inform producers about the need to access communication products such as HIV statistics 

from a gender angle. Depending on the degree of comprehensiveness of their data communication 

strategies, statisticians might be able to put together brochures, blogs, newsletters, infographics and 

materials for social media dissemination, while liaising with journalists for the uptake of this data by more 

traditional forms of media. Interaction with users to assess data needs and their degree of statistical 

literacy is important to ensure the communication products are used widely. Similarly, dialogue to share 

the key findings with the users will also enhance the chances of data being used. For further details about 

user-producer dialogues, including guidelines on how to organize these, please refer to Module 4 of this 

training curriculum.  

 

1.2. How can data producers communicate gender data? 
 

Stage 1: Pre-production dialogue 

It is important for National Statistical Offices (NSOs) and statistical units in ministries to be aware of users’ 

needs when producing data. In line with the Fundamental Principles of Official Statistics6, this means data 

should be relevant for users, made openly and consistently available and must get widely used7. With 

these guiding principles, users must be at the centre of the data production process. 

Before producing data and generating data communication products, users’ needs and priorities must be 

assessed. Identifying users’ needs might range from identifying priority topics and indicators, to assessing 

which population groups are relevant for data disaggregation and understanding the types of formats and 

communication methods that are considered most convenient by users. Reaching an understanding on all 

these issues is also essential to ensure the quality of the data. For instance, user-producer dialogue might 

help identify the need to produce data for a specific population group, such as women with disabilities. 

 
6 See UNSD https://unstats.un.org/unsd/dnss/gp/FP-New-E.pdf 
7 See UNSD https://unstats.un.org/unsd/dnss/gp/fp-english.pdf 

User-producer 
dialogue to 

identify user's 
needs

Data is 
produced 

taking user's 
expertise and 

needs into 
account

Data reaches 
users in the 
right format

Data produced 
meets user's 
needs and its 
use increases

Figure 4: Users should be at the centre of the data production and communication process 

https://unstats.un.org/unsd/dnss/gp/FP-New-E.pdf
https://unstats.un.org/unsd/dnss/gp/fp-english.pdf
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To produce gender statistics for the disabled population, sample sizes must be larger so that data can be 

disaggregated at multiple levels without compromising reliability. Thus, understanding user’s needs and 

planning data collection and communications accordingly are essential to ensure the reliability of the data, 

including disaggregation. 

User-producer dialogues are often anchored around particular topics, such as Sustainable Development 

Goals (SDG) statistics, gender statistics or others. In Asia and the Pacific, many countries have 

institutionalized these dialogues and used them to enhance the production of gender-related SDG data. 

In Viet Nam, for instance, user-producer dialogues were used in 2018 and 2019 for the selection of a set 

of priority gender-related SDG indicators. The engagement of users and producers throughout this SDG 

localization process was particularly important to ensure the data prioritized for production was in line 

with user’s needs. The process, which was supported by UN Women and UN ESCAP, resulted in a priority 

set of gender indicators that are now periodically used to generate the publication “Men and Women in 

Vietnam”. The selection of indicators was achieved through the use of the EPIC tool8. Besides being useful 

for SDG localization, this tool creates opportunities for dialogue, and therefore ultimately supports 

enhancing the use of gender statistics9. Through a dialogue process, EPIC supports users and producers in 

analyzing existing national policies to identify key priorities for data production. EPIC also enables dialogue 

to identify indicators that could be used to measure progress on such priorities. Figure 4 shows the process 

of user-producer dialogue for data and policy integration and SDG localization10: 

 

 

 
8 See: https://www.unescap.org/sites/default/files/EPIC%20Overview%20%28EPIC_V1.1_Final%29.pdf 
9 See ESCAP https://www.unescap.org/sites/default/files/EPIC%20Overview%20%28EPIC_V1.1_Final%29.pdf  
10 For further details on this, refer to Module 12 of this Training Curriculum 

Prepare for the analysis of policies 

 

1) Identify potential members to form a team for analysis (ideally data users and producers) 

2) Identify a policy document for the analysis (e.g. the national gender equality strategy) 

3) Identify a section of the policy to analyze 

4) Read and understand the definitions of issues, target groups, core concepts and key 

 questions 

 

Carry out the analysis of policies 

 

5) List issues and target groups reflected in the policy document 

6) Associate “issue” and “target groups” with core concepts 

7) List issues and target groups not included in the policy  

8) Identify a list of indicators for the issues identified in the policy  

9) Map the indicators to the existing regional/international indicator set(s) 

10) Develop a matrix illustrating policy as well as indicator strengths and gaps 

 

Figure 5: Using EPIC for Data-Policy integration 

https://www.unescap.org/sites/default/files/EPIC%20Overview%20%28EPIC_V1.1_Final%29.pdf
https://www.unescap.org/sites/default/files/EPIC%20Overview%20%28EPIC_V1.1_Final%29.pdf
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After the selection of indicators and the production of related data, further dialogue needs to take place 

to identify specific communication products needed, as well as ideal formats and communication 

channels. 

Stage 2: Post-production dialogue 

Data must be communicated taking users’ expertise into account and it should reach the users in an 

accessible format. The post-production dialogue should put the data into context so that it is relevant for 

the user. It should include information on the new estimates produced, where to find them and how to 

interpret them. It should also include information on future releases and provide an opportunity to 

establish communication channels for future exchanges. For instance, this dialogue can help create links 

between users and producers that will facilitate data requests in the future. Similarly, it can be used to 

build trust between users and producers, which might result in enhanced sharing and use of the data.  

Users’ level of expertise should be considered when data is being produced and communicated. As the 

level of expertise increases, communication products should become more detailed. For non-expert users, 

simpler and less detailed data products are preferable, while expert analysts and researchers would 

expect more detailed and granular data products.11 

 

 

 

 

 

 

 

 

 

 

 

 
11 Workshop on communicating gender data: promoting better use and delivering impactful messages 
https://www.dropbox.com/sh/qqphczg5bqg10hg/AAAzHf9hH5vWhOohsLgkEyWDa/Session%203a%20_Communic
ating%20gender%20data%20for%20policy-making%20and%20beyond.pdf?dl=0  
 

Level of detail increase As level of expertise 

increases 

Figure 6: Tailoring communication product according to user's expertise 

https://www.dropbox.com/sh/qqphczg5bqg10hg/AAAzHf9hH5vWhOohsLgkEyWDa/Session%203a%20_Communicating%20gender%20data%20for%20policy-making%20and%20beyond.pdf?dl=0
https://www.dropbox.com/sh/qqphczg5bqg10hg/AAAzHf9hH5vWhOohsLgkEyWDa/Session%203a%20_Communicating%20gender%20data%20for%20policy-making%20and%20beyond.pdf?dl=0
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2. Common channels and products for communicating gender data and 

how to use them effectively 
Gender data can be communicated through many channels and products. Examples of channels, or media 

of communication, include websites or data portals. Examples of products include reports and 

infographics. An effective communication strategy includes key messaging and products aimed at relevant 

target audiences across relevant channels to optimize outreach. When identifying potential users and 

their needs, it is key to take communication channels and products into consideration and utilize different 

channels and products for different types of users to suit their needs. Some of the commonly used 

channels and products for communicating gender data include:  

2.1. Databases, repositories and compilations of data  
Rather than communication channels, these are avenues for data dissemination. However, they have 

been included in this list because they are an important starting point to access data that could be used 

to build communication products. A database is generally understood as an organized collection of data 

wherein information is interrelated, managed and stored as a unit12. Take the example of a simple table 

with data entries for a given number of people on variables such as age, sex, height, weight, etc. This 

table, which contains data in an organized and logical manner (columns contain categories such as age, 

weight, sex, etc. and each row contains a record for each person) can be called a data set. Hence, a 

database can be understood as a collection of data sets. An example of a database containing a large 

amount of data for different countries, time periods and indicators is the SDG database13. An example of 

a gender-specific database is the Women Count data hub14 developed by UN Women. 

Some examples of databases include:  

 

 
12 https://stats.oecd.org/glossary/search.asp 
13 https://unstats.un.org/sdgs/indicators/database/  
14 https://data.unwomen.org/data-portal  

https://stats.oecd.org/glossary/search.asp
https://unstats.un.org/sdgs/indicators/database/
https://data.unwomen.org/data-portal
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- National databases: These databases store nationally calculated estimates and are generally 

managed by the NSO of a country or another specific data-producing ministry such as the Ministry 

of Health or the Ministry of Education. The following is an example from the SDG national 

database for Mongolia15.  

 

In this online database, the user can select data for a range of SDG indicators, across different 

time periods. For instance, if the user wants to see data for Goal 5 (on Gender equality and the 

empowerment of women), they just need to scroll down, and they will find data for the SDG 

indicators of Goal 5 (see Figure 8):  

 
15http://sdg.1212.mn/EN/Home/Information  

Figure 7: National SDG Database, Mongolia 

Figure 8: Gender-specific indicators, SDG Database, Mongolia 

http://sdg.1212.mn/EN/Home/Information
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- Global databases: Global or international databases typically include data for numerous 

indicators and countries. These databases are particularly useful for comparison purposes. As 

such, it is important that the estimates included in global databases are in line with international 

concepts and definitions. In select instances, national estimates might be adjusted to ensure 

comparability across countries. This can sometimes result in discrepancies between national and 

international estimates for the same data point. It is important to use footnotes and/or metadata 

sheets to note these methodological challenges. As a data user, it is also important to read the 

metadata to understand these challenges. The Global SDG Indicators Database16 is an example of 

a global database. It is an interactive platform that allows users to make data requests for a range 

of indicators, geographic regions and time periods. After making a selection (data query), the user 

may obtain a customized table, as shown in Figure 9.  

  

 

 

- Interactive data interfaces: Interactive data interfaces allow users to easily manipulate data for 

ease of use. An example is UN Women’s Data portal17. The interface allows users to make queries 

 
16 https://unstats.un.org/sdgs/indicators/database/  
17 https://data.unwomen.org/data-portal  

Figure 9: Global SDG Indicators Database showing select data tables 

https://unstats.un.org/sdgs/indicators/database/
https://data.unwomen.org/data-portal
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(select data, indicators, regions, time period, etc.) and set parameters to generate data 

visualizations instantly, in the form of maps, bar graphs and line charts, among others.  

 

 

 

 

 

 

 

 

- Pre-processed micro-databases: These are databases that draw on microdata (e.g. survey or 

census data) but where some basic calculations have already been completed by developers. As 

opposed to microdata repositories, micro-databases have survey and census estimates ready to 

use. Thus, the user is able to make selections – pertaining to population groups, age groups, 

variables, etc. – and cross-tabulate information as desired, without utilizing statistical software. 

One such example is DHS STATcompiler, a tool that allows users to build custom tables, charts 

and maps from thousands of indicators extracted from Demographic and Health Surveys (DHS) 

across 90 countries18. Figure 10 displays an example of the type of data that can be found in 

STATcompiler.  

 

 

 
18 https://dhsprogram.com/data/STATcompiler.cfm 

Figure 10: UN Women Data Portal 

Figure 11: Pre-process Demographic and Health Survey microdata, as extracted from STATCompiler 

https://dhsprogram.com/data/STATcompiler.cfm
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- Microdata repositories: These are repositories of survey data or census data. That is, users are 

able to access individual-level records, rather than nationally aggregated estimates. Examples of 

microdata repositories include DHS19 and MICS20 repositories, for surveys, as well as IPUMS21 

International for census data. DHS and MICS data sets are examples of survey data with 

information on multiple indicators of well-being for women and men, including maternal and 

reproductive health, family planning, nutrition, etc.22 After requesting access to data sets, these 

can be downloaded and analysed with computer software such as STATA, SPSS, or R.  

 

 

 

 

 
19 Demographic and Health Surveys, see: 
https://dhsprogram.com/data/dataset_admin/login_main.cfm?CFID=150963&CFTOKEN=e1c1d13f58d3
4a15-DBEC21C1-F1FB-3EB5-7CDC977190C0B912  
20 Multiple Indicator Cluster Surveys, see: https://mics.unicef.org/surveys  
21Integrated Public Use Microdata Series, see: https://usa.ipums.org/usa/data.shtml  
22 https://dhsprogram.com/topics/More-Topics.cfm 

Figure 12: DHS Microdata Repository, example for Individual Recode for Bangladesh 2014 

https://dhsprogram.com/data/dataset_admin/login_main.cfm?CFID=150963&CFTOKEN=e1c1d13f58d34a15-DBEC21C1-F1FB-3EB5-7CDC977190C0B912
https://dhsprogram.com/data/dataset_admin/login_main.cfm?CFID=150963&CFTOKEN=e1c1d13f58d34a15-DBEC21C1-F1FB-3EB5-7CDC977190C0B912
https://mics.unicef.org/surveys
https://usa.ipums.org/usa/data.shtml
https://dhsprogram.com/topics/More-Topics.cfm
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In this repository, for each country and year, the user is taken to a list of resources comprising 

data sets for specific population groups (e.g. women, men, children, etc.) in different file formats, 

as shown in Figure 12.  

 

- Database of Databases: Data producers who coordinate data dissemination from different 

sources (such as National and International Statistical Coordination Authorities) can benefit from 

hosting a Database of Databases (DoD). In other words, centralizing existing databases in an 

organized manner can help users access the most relevant data whenever they wish, for a given 

project. An example of a DoD is Eurostat’s23 list of databases by thematic areas. When each theme 

is expanded, a list of sub-themes and relevant databases appears. As databases are live platforms, 

i.e. they are regularly updated, changes to URLs must be monitored to ensure the DoD remains 

up-to-date.   

 

 

 

 

 

 

 
23https://ec.europa.eu/eurostat/data/database?p_p_id=NavTreeportletprod_WAR_NavTreeportletprod_INSTANC
E_nPqeVbPXRmWQ&p_p_lifecycle=0&p_p_state=normal&p_p_mode=view&p_p_col_id=column-
2&p_p_col_pos=1&p_p_col_count=2 

Figure 3: DHS Survey datasets 

https://ec.europa.eu/eurostat/data/database?p_p_id=NavTreeportletprod_WAR_NavTreeportletprod_INSTANCE_nPqeVbPXRmWQ&p_p_lifecycle=0&p_p_state=normal&p_p_mode=view&p_p_col_id=column-2&p_p_col_pos=1&p_p_col_count=2
https://ec.europa.eu/eurostat/data/database?p_p_id=NavTreeportletprod_WAR_NavTreeportletprod_INSTANCE_nPqeVbPXRmWQ&p_p_lifecycle=0&p_p_state=normal&p_p_mode=view&p_p_col_id=column-2&p_p_col_pos=1&p_p_col_count=2
https://ec.europa.eu/eurostat/data/database?p_p_id=NavTreeportletprod_WAR_NavTreeportletprod_INSTANCE_nPqeVbPXRmWQ&p_p_lifecycle=0&p_p_state=normal&p_p_mode=view&p_p_col_id=column-2&p_p_col_pos=1&p_p_col_count=2
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2.1.1. How to use a database to disseminate gender data effectively  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The purpose of a database is to make data and related information widely available to users. In other 

words, databases are dissemination tools and not necessarily communication tools. However, utilizing 

databases is a necessary step towards building a data communication product. To maximize their use, it 

is important that these are user-friendly. That is, they must have the information structured in an intuitive 

way for different types of users. For instance, the Philippine’s SDG indicator database24 allows users to 

find data through searching by SDG goals. However, for users interested in gender issues, this might pose 

a challenge, as gender is a cross-cutting area across multiple SDG goals. Thus, the Women Count data 

portal also offers the ability to search by topic; with gender being one of the thematic topics, as shown in 

Figure 15 below.   

 

 
24 http://openstat.psa.gov.ph/Database/Sustainable-Development-Goals  

Figure 14: Tree structure of database, EUROSTAT 

Figure 45: SDG Dashboard, UN Women Data Portal 

: Ge 

http://openstat.psa.gov.ph/Database/Sustainable-Development-Goals
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In addition, because different types of users have different levels of skills to analyze data, it is important 

that databases allow for data downloads in different formats. For instance, while many users would like 

to download CSV files to build simple graphs in Excel, others might prefer to download STATA files to 

conduct more sophisticated analysis. Furthermore, there might be some users that lack the knowledge to 

create graphs and analysis with basic computer software; therefore,  interactive data interfaces that 

allow for graph-building through queries might better suit the  needs of this set of users.   

 

2.2. Reports 
Reports are an organized synthesis of data that span a whole array of forms, ranging from tables of 

numbers to a text summarizing them25. Communicating data via reports is one of the most common 

channels of communication between data users and producers. Statistical reports typically focus on 

presenting the findings of surveys or other data-collection exercises, and can vary in their focus, level of 

detail and visual elements. One example is the Bangladesh MICS survey report26  in Figures 16 and 17. 

 

 

 

 

 

 

 

 
25 https://pdfs.semanticscholar.org/3868/92bd216e3802c77d006ff0bae02e00ba6f33.pdf 
26 Progotir Pathey, MICS Bangladesh http://203.112.218.65:8008/WebTestApplicat ion/userfiles/Imag 
e/LatestReports/MICS%202012-13.pdf 

Figure 16: Bangladesh MICS Survey Final Report, 2012-13 

https://pdfs.semanticscholar.org/3868/92bd216e3802c77d006ff0bae02e00ba6f33.pdf
http://203.112.218.65:8008/WebTestApplicat%20ion/userfiles/Imag%20e/LatestReports/MICS%202012-13.pdf
http://203.112.218.65:8008/WebTestApplicat%20ion/userfiles/Imag%20e/LatestReports/MICS%202012-13.pdf
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The focus of this report is to monitor the situation of women and children in Bangladesh. The presentation 

of data is in the form of tables and graphs.  

 

 

In addition to presenting findings, survey reports often describe the survey methodology, providing 

information on survey design, the data collection process, strengths and limitations, a copy of the 

questionnaire used, etc. This information is important for the user to assess the reliability of findings and 

to interpret the data correctly.  

When statistical reports go beyond showcasing data and analysis from a single instrument (e.g. survey 

reports) and instead portray an evidence-based analysis of progress for a country or a set of countries for 

different time periods and issues, these are often referred to as progress reports. Progress reports, as 

shown in Figure 1827, typically include data in the form of tables, graphs or infographics, with 

accompanying text to describe the progress observed over time.   

 

 

 

 

 

 

 
27 https://data.unwomen.org/progress-of-the-worlds-women  

Figure 17: Visual elements in Bangladesh MICS final report 

https://data.unwomen.org/progress-of-the-worlds-women
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2.2.1. Data visualization for statistical reports  
 

Statistical reports can vary in terms of topic, detail, length and use of visual elements. Although one 

particular approach may not fit all reports, some general recommendations on using data visualizations 

for statistical reports include:  

- Replace or complement text with visuals where possible and relevant: Long pieces of text can be 

boring and seem monotonous to readers. Adding relevant text in a box can also help break the 

monotony of the content and highlight a key message. Figure 19 shows an excerpt from a UN 

Women publication28. Although a substantial amount of text has been included, a change in 

 
28 https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2018/sdg-report-
gender-equality-in-the-2030-agenda-for-sustainable-development-2018-en.pdf?la=en&vs=4332 

Figure 18: Progress of the World’s Women, 2019-20 

https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2018/sdg-report-gender-equality-in-the-2030-agenda-for-sustainable-development-2018-en.pdf?la=en&vs=4332
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2018/sdg-report-gender-equality-in-the-2030-agenda-for-sustainable-development-2018-en.pdf?la=en&vs=4332
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typography (color of headlines, font style and size) as well as addition of a simple bar chart makes 

it engaging for the reader.  

 

 

 

Figure 19: Turning Promises into Action, UN Women, 2018 
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29 

 

Add complimentary elements and context to visuals: Visuals without accurate descriptions can be 

challenging to interpret or lead to misinterpretation. Ensure graph titles are comprehensive, accurate and 

easily understandable. Subtitles, footnotes and short explanations can be added to the graph to convey 

the full message accurately. For instance, Figure 20 shows a graph with an accurate and comprehensive 

title, relevant legends, footnotes and axis titles. With this information, readers are more likely to interpret 

the data correctly.  

- Know the print size limits: If producing for print or web, know what your print size limits are, 

as this will determine how long or wide your visual/web infographic will be.  

 
29 https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-
of-the-worlds-women-2019-2020-en.pdf?la=en&vs=3512 

Figure 20: Example of bar graph with comprehensive complementary elements, UN Women’s 
publication, Progress of the world’s women, 2019 

https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-of-the-worlds-women-2019-2020-en.pdf?la=en&vs=3512
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-of-the-worlds-women-2019-2020-en.pdf?la=en&vs=3512
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2.2.2. How to use reports to communicate gender data effectively  
 

The following tips can help ensure that gender-related findings are communicated effectively through 

reports: 

- Identify the target audience before crafting a report and tailor the content, the level of detail, and 

the type of language to the target audience.  

- Focus on topics that are a priority for the target audience. Remember that gender analysis can be 

integrated through a variety of topics, so gender statistics should be present across many forms 

of reports, not just reports on gender statistics and social statistics. 

- Utilize gender statistics for non-statistical reports as well. Utilizing data can help get your point 

across and convey powerful messages. For a non-expert audience, avoid utilizing technical 

language and long explanations around complicated statistical methods. 

- Always include insights and context into the gender data used and discuss the caveats of the data. 

This is especially important to ensure the correct interpretation of the estimates.  

- Always keep a balance between information showcased through graphs and text, to enable 

readers to get the full picture in an engaging way. You can even add text boxes to call reader’s 

attention to a certain topic, definition or fact. 

- In the presentation of gender statistics through graphs, women and men should be presented 

side-by-side and the words “women” and “men” and “girls” and “boys” should be used instead of 

“females” and “males” (which have a social connotation)30. 

- Unless there is a reason not to (e.g. keeping alphabetical order), order your data from lowest to 

highest value before showcasing it through graphs and charts. Displaying the data in a ranked 

manner allows readers to make comparisons easily. In the case of visualizing multiple sets of data 

(such as Figure 21 below) choose the parameter you wish to compare (i.e. women) and order 

according to that value. 

 
30 UNSD https://unstats.un.org/unsd/demographic-social/Standards-and-
Methods/files/Handbooks/gender/Integrating-a-Gender-Perspective-into-Statistics-E.pdf 

Box 1: UNDESA Recommendations for presenting gender data in reports, 2017 

 

- Women and men should be presented side by side to facilitate comparison  

- Women should always be presented before men 

- Use words ‘women’ and ‘men’ instead of ‘female’ and ‘male’ as the latter may have social connotation 

- Data should be rounded to 1,000, 100 or 10 and percentage should be rounded to integers, to facilitate 

comparison between women and men 

- Gender-blind totals should be deleted in tables and graphs  

https://unstats.un.org/unsd/demographic-social/Standards-and-Methods/files/Handbooks/gender/Integrating-a-Gender-Perspective-into-Statistics-E.pdf
https://unstats.un.org/unsd/demographic-social/Standards-and-Methods/files/Handbooks/gender/Integrating-a-Gender-Perspective-into-Statistics-E.pdf
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31 

 

 

 

 

 

 

 

Source: UN Women’s calculation based on Demographic and Health Surveys (DHS) for 42 countries (ICF 2007–2017) and Multiple Indicator Cluster 

Surveys (MICS) for 28 countries and territories (UNICEF 2019). 

 

- Refer to section 3.1 of this syllabus for more detail about the types of graphs you should use for 

each occasion.  

- Always footnote data sources and references to ensure the reader can access additional resources 

for more information.  

 

 

2.3. Factsheets 
A factsheet is a stand-alone informational overview intended for a general and non-technical audience32. 
Typically, statistical factsheets present data, key findings and messages related to the data in a format 
that emphasizes these messages concisely, usually through graphics, tables and/or headings, without 
much accompanying text. Typically, a factsheet contains facts or quick information about an issue 
(thematic fact sheets – see: Women’s Rights in review, 25 years after Beijing33) or a place (country fact 
sheets – see: Fiji country factsheet34). Figure 22 shows how a factsheet can concisely communicate an 
overview of the global state of affairs for Goal 5 of the SDGs.35 

 

 
31 https://data.unwomen.org/progress-of-the-worlds-women 
32 https://extension.usu.edu/employee/online-review-submission  
33 https://data.unwomen.org/publications/generation-equality-womens-rights-review-25-years-after-beijing 
34 https://data.unwomen.org/countries 
35 https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-
on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf  

Figure 21: Proportion of individuals aged 15-49 who justify wife beating, by sex and reasons given, UN 
Women 2019 

https://data.unwomen.org/progress-of-the-worlds-women
https://extension.usu.edu/employee/online-review-submission
https://data.unwomen.org/publications/generation-equality-womens-rights-review-25-years-after-beijing
https://data.unwomen.org/countries
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
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36 

 

 

 

 

2.3.1. Data visualization and information design for factsheets  
Given that a factsheet is usually a very short product (one or two pages, if printed) describing only key 

points, it is important to achieve a balance between data, visuals and narrative in a very condensed space. 

These information elements can be arranged as follows:  

 

 
36 https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-
on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf 

Figure 22: Goal 5 factsheet, UN Women, 2019 

https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
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- Start by giving a clear title that truly summarizes the content of the factsheet without making it 

too technical.  

- Give brief background to set the context. It is usually best to have a narrative or a key takeaway 

for users, which will also help organize the data you present. 

- In some cases, compliment this with a relevant, gender-sensitive image that your audience can 

connect with. Avoid using images that stereotype or are not in the context of the data set. In the 

case of data pertaining to sensitive topics, such as violence against women, it’s best to avoid 

images altogether, even more so if they pinpoint one individual or women as battered or abused. 

Given the limited space, the use of images is only encouraged in headers or cover pages. 

- Choose three to five key points you want to highlight.  

- Contextualize text with accurately and succinctly labelled data visuals. Visuals make the document 

less boring and catch people’s attention. Make sure the data sources are provided to ensure 

transparency and allow users to find more details about the data. 

- Maintain a coherent visual identity, colour scheme, typography and margin sizes throughout the 

factsheet. 

Figure 23: Example of structure and design elements of factsheet 



27 
 

 

37 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Maintain a balance between the ratio of text to visual elements. Although there is no rule of 

thumb when it comes to this ratio, generally for every piece of visual, there should be a brief 

supporting text.  

- Utilize icons and graphic elements that are understandable universally and without explanation. 

- Utilize icons and graphic elements that are culturally appropriate (please refer to the infographic 

section below for more information on this).  

 
37 https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-
on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf  

Figure 5: Factsheet showing key gender-environment related information in a snapshot, UN Women 
2019 
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https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
https://www.unwomen.org/-/media/headquarters/attachments/sections/library/publications/2019/progress-on-the-sdgs-the-gender-snapshot-2019-two-page-spreads-en.pdf
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- Target a specific issue or set of related issues and maintain a coherent narrative, as your 

organizing principle. Stay away from showcasing a number of unrelated issues. Factsheets are 

meant to be focused documents, with a connecting thread through the statistics showcased. Thus, 

if showcasing a number of different unrelated indicators from a gender perspective, it would be 

important to highlight (through the title and accompanying text) the reason for clumping all those 

components together in the factsheet. This can be as easy as crafting the title into the format 

“Gender inequalities across the SDGs”, for instance. Here, the connecting thread would be the 

SDGs, with gender gaps guiding the data and messaging showcased. 

 

2.4. Media  
Gender data and statistics play a core function for journalists who intend to build evidence-based gender 

stories38. National Statistics Offices often engage with journalists to support the crafting of media stories. 

Ideally, this engagement should go well beyond press releases on data collection exercises and survey 

reports. In fact, it is generally more effective to build long-term partnerships with journalists whereby 

communication flows are institutionalized, so data producers can target their statistics and the format in 

which these are released to the needs and interests of the media and the general public. For instance, 

through a partnership with UN Women, Devex’s website now hosts a special focus area on gender data39, 

where periodic news stories are uploaded on this topic. 

Communications between statisticians and media personnel can sometimes be challenging due to the 

different professional backgrounds and technical skills. While statisticians often find challenges around 

media personnel failing to understand and interpret statistics correctly, journalists’ challenges often 

revolve around statistics not being openly accessible, being produced in formats that are difficult to 

consume, or unavailable altogether for the topic of interest. Some targeted recommendations to 

overcome some of these challenges are listed in Box 2 below:   

 

 

 

 

 

 

 

 

 

 

 
38 Rukmini Srinivasan. Workshop on communicating gender data: promoting better use and delivering impactful 
messages. 13th June 2019. https://www.unescap.org/events/workshop-communicating-gender-data-promoting-
better-use-and-delivering-impactful-messages 
 
39 See: https://www.devex.com/focus/gender-data 

https://www.unescap.org/events/workshop-communicating-gender-data-promoting-better-use-and-delivering-impactful-messages
https://www.unescap.org/events/workshop-communicating-gender-data-promoting-better-use-and-delivering-impactful-messages
https://www.devex.com/focus/gender-data
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Some good lessons on institutionalizing dialogue with journalists can be learned from the experiences of 

the Philippine Statistical Authority and the Philippine Statistical Research and Training Institute (PSRTI), 

which organize periodic training and communication events for  journalists. For instance, the Philippines 

 

- Create long-lasting relationships with media organizations and individual journalists. 

Institutionalizing dialogue between statisticians and media professionals can help target data 

production and reduce data waste significantly. Consult media professionals before collecting and 

releasing data to ensure the data and the format fits their needs. 

 

- Build the statistical capacity of journalists. This can be done through partnerships with academic 

institutions and schools of communications and journalism, or through hands-on training events 

catering to media personnel. Building their capacity should include training on statistical literacy, 

guidance for data interpretation, guidance for data source identification and evaluation, 

technical support for data visualization and training on fact-checking for accuracy. 

 

- During press releases and other data release events, it is important to come prepared with key 

messages that should be repeated a few times throughout the event. It is best to select fewer key 

messages for the most effective impact. For selecting the key messages, it is important to keep in 

mind that the client is ultimately the reader, listener or viewer, and not the reporter. Moreover, 

the message should walk the fine line between being ‘newsworthy’ and sensationalist or 

misleading.  

 

- Be helpful to reporters by being responsive and designing materials that support your message 

and are useful to the media, like fact sheets (see above) 

 

- Convey messages that aren’t overly scientific but, at the same time, leave no room for 

interpretation by highlighting definitions and caveats in simple wording.  

 

- During public events, never say “no comment”, never go off the record, and never lie. It is 

important to avoid making up messages or explanations. If journalists ask questions for which 

you don’t have answers, it is recommended to state that you don’t know but get their contact 

details to follow up with facts later on.  

 

- Set up periodic communication events such as press briefings to convey information and compile 

insights regarding journalists’ interests and technical background.   

 

Box 2: Recommendations of data producers 
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Statistics Authority held its first data festival, a two-day event for engaging data users with data and 

statistical literacy. It was targeted at promoting proper interpretation and use of official statistics among 

media practitioners and other data user40.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
40 https://psa.gov.ph/datafestival 

Figure 6: Publication of data communication workshop by the Philippine Statistical Authority 

https://psa.gov.ph/datafestival
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- Be mindful of the differences between official and non-official statistics and choose official 

statistics whenever available. Also, educate your audience about this. It is important that you 

convey to your audience that official statistics typically carry more weight as they are compiled 

in a more rigorous way, utilizing large sample sizes, and making use of large teams of 

enumerators. If utilizing non-official statistics (such as small surveys, private sector data, and 

other ad-hoc data collection exercises) it is also important that you highlight to your audience the 

ad-hoc nature of the data and the limitations associated with it.  

 

- Once you have selected the data that you want to use, ensure that you read the associated 

metadata (refer to Modules 1 and 2 for details on Metadata) to fully understand definitions, 

methods of computation, data sources and caveats. This will help interpret the data correctly.  

 

- If you find caveats on your data, include information about the caveats in your media product, 

either through footnotes or through simple explanations so the readers understand the reliability 

and significance of the figures.   

 

- Make sure you are interpreting the data correctly and utilize the right language to refer to it. 

Besides reading the metadata, it is important to pay attention to the use of words such as 

percentage, percentage points, proportion, ratio and rate (refer to Module 2 for details on the 

differences). Similarly, statistical concepts such as mean, median and average aren’t typically 

interchangeable, so it is important to be mindful. (Please refer to Module 2 on Interpreting Gender 

Data for details on this). 

 

- If you cannot find the data you are looking for, do not assume the data does not exist. Reach out 

to the National Statistics Office for guidance. In occasions, they may grant journalists access to 

specific data sets or work with them to draft stories. Remember to contact statisticians well in 

advance to ensure the data can be provided on a timely manner.  

 

- If the data is not available in the exact format you are looking for, you can also contact national 

statisticians to request different formats, or you can transform it yourself. In many countries (as 

explained above), National Statistical Training Institutes organize periodic training events for 

journalists to gain this type of knowledge. If you modify the data yourself, consider sending your 

findings back to the data producers for their final validation before publication.  

 

- If you find that, even after contacting national statisticians, the data you are looking for is 

unavailable, use your media product to highlight important gender data gaps and raise public 

awareness on the importance of enhancing the availability of gender statistics.  

Box 3: Recommendations for journalists and communicators 
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There are many different types of media products. In this chapter, the focus will be on three of the most 

common media products: Written articles, audiovisual media and social media.  

2.4.1 Written articles 

 
Written articles typically appear in newspapers, printed or online, or organizational websites and blogs. 

Written articles often include a headline, an introductory paragraph, the body of the article, and a closing 

paragraph.   
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Figure 7: Example of written article showing key elements, Hindustan Times, 2017 
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Headlines:  

To capture the reader’s interest, it is important to craft a concise headline and introductory paragraph 

that conveys the overarching key message. The headline itself may or may not include gender data, but it 

must outline the main message. An example of a gender data-based article headline could be, for instance: 

“US maternal mortality doubled in the last 25 years”41.  This is a powerful headline because it is easy to 

understand, it conveys information about what is new, and it gives the reader an idea of what to find in 

the article.  

 

A few general tips to writing an effective headline are42: 

 

- Ensure that headlines are factually correct 

- Convey the overall message and capture the essence of the story through relevant keywords 

- Don’t mislead the reader 

- Use active, short, action verbs 

- Think about the reader and make sure it captures their attention 

- Keep it short and jargon-free (and conversational where appropriate for the target audience) 

 

Introductory paragraph:  

The first paragraph in an article should summarize the key findings, providing more detail than the 

headline. The build-up on data and statistics should be gradual and cater to the audience’s level of 

expertise, while also setting some context. In long-form or feature articles, an opening paragraph can 

start-off with a human-interest story before jumping into the data.  

 

Body of the article:  

The main body is where the central idea is discussed in greater detail and delves deeper into the context, 

layering in additional dimensions that enhance the overall key message. Depending on the target 

audience, it is recommended that the body of the article vary in length and detail and it can be divided 

into subsections. It is also in the body of the article that you must add visual representations of data, such 

as graphs, charts, maps or infographics and include supporting text to explain these visual elements.  

 

A few essential tips to write an article utilizing gender data include: 

 

- Start with a newsworthy message. This can be related to current events, or simply new 

developments and/or findings. 

- Find official data associated with your story idea and let the data influence your messaging, rather 

than the other way around. 

- Check your facts, be objective and offer balance. 

- Utilize data from reliable sources and always indicate the sources. 

- Don’t censor yourself. 

- Go beyond basic news reporting. 

- Go beyond headline data, and provide additional data points to add detail. 

 
41 http://www.facethefactsusa.org/facts/more-us-mothers-dying-despite-expensive-care/  
42https://books.google.co.th/books?hl=en&lr=&id=ekyU8CoNwNwC&oi=fnd&pg=PA9&dq=headline+writing&ots=X
QysFZrmZN&sig=ZHS-ksQG9w6PQUgLBD5NvwDPOBU&redir_esc=y#v=onepage&q=headline%20writing&f=false 

http://www.facethefactsusa.org/facts/more-us-mothers-dying-despite-expensive-care/
https://books.google.co.th/books?hl=en&lr=&id=ekyU8CoNwNwC&oi=fnd&pg=PA9&dq=headline+writing&ots=XQysFZrmZN&sig=ZHS-ksQG9w6PQUgLBD5NvwDPOBU&redir_esc=y#v=onepage&q=headline%20writing&f=false
https://books.google.co.th/books?hl=en&lr=&id=ekyU8CoNwNwC&oi=fnd&pg=PA9&dq=headline+writing&ots=XQysFZrmZN&sig=ZHS-ksQG9w6PQUgLBD5NvwDPOBU&redir_esc=y#v=onepage&q=headline%20writing&f=false
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- Encourage readers to question data systems and understand the quality of the data points. 

- Find a compelling narrative. 

- Complement your text with engaging graphics that convey information effectively (refer to 

section 3 on visualizations). 

- Complement your article with a quote from an expert to enhance key messaging or provide 

relevant context. 

- Don’t get lost in too many data points. Find a balance between how many data points to include 

in your article to support your narrative and key messaging without overwhelming your target 

audience. 

 

Prior to writing the body of your article, think about your audience and ask yourself the following 

questions:  

- Is it their first exposure to the subject? If yes, keep it simple and jargon-free but don’t oversimplify.  

- Are they aware of the topic but looking for a better understanding? If yes, provide more detail, 

along with an outline with major themes and recent developments.  

- Are they experts on the topic? If yes, provide in-depth, actionable understanding of intricacies 

and interrelationships with access to details. For expert audiences, it is better to provide more 

opportunities for exploration and discovery. 

 

Closing paragraph: 

The closing paragraph is essential to reinforce the key message of the article. It should be a succinct 

summary of what has already been talked about in the article, and it can point to the future or make 

suggestions. In some cases, the closing paragraph might relate to the opening paragraph if, for instance, 

a human story has been used to open the article. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

Figure 8: News article on maternal mortality, UN News, New York 2019 
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Editorial quality43 

In order to maintain editorial quality, all content must be fact-checked and sourced. When writing each 

piece of content, the following44 points must be considered: 

• Findable - Can the user find the content? Use header tags and metadata. 

• Readable - Can the user read the content? Tailor the style to the target audience. 

• Understandable - Can the user understand the content? Consider the user type and the content 

type. 

• Actionable - Will the user want to take action? Can you easily share or comment where 

appropriate? 

• Shareable - Will the user share the content? Make it easy to share using social media and 

hashtags. 

 

2.4.2 Data visualization and information design for written media stories  
As has already been mentioned in section 2.4.1, effective data-driven media stories are those which have 

an appealing headline, simplify statistics, provide context, adjust the language and content to target users’ 

expertise and are guided by data. How this information is structured and laid out also adds to what will 

be an effective media story. Some general recommendations on using data visualization for written media 

stories include: 

 
43 Mika Mansukhani, What is a Gender Data Story, UN Women, 2019. 
44 See: https://contentmarketinginstitute.com/wp-content/uploads/2011/04/leibtag_content_checklist.pdf 

Figure 9: News article on maternal mortality, Economic Times, India 2019 
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- Include graphs, infographics and iconography that make information relatable to the audience. 

Adding these at the start can help the reader engage with the article. Figure 2945 is an example of 

how simple icons and graphs can be used to break the ice with the reader: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Build on the same message by using a different data point and a new data visual to add variety as 

well as to reinforce the message. Figure 29 is an excerpt from the same article as shown in Figure 

30, below. 

 
45 https://www.dw.com/en/women-work-for-free-while-billionaires-accumulate-wealth/a-52045840  

Figure 10: Excerpt of written news story showing simple visual representation of data, entitled ‘Women 
Work For Free While Billionaires Accumulate Wealth’, published in Deutsche Welle 2020 
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- Keep a coherent color scheme throughout the news article.  

- Add authentic, contextually accurate, non-stereotypical and gender-sensitive images to make the 

content of the article relatable to the readers. Where possible, include the story and context of 

the photo subject in the article or caption. For instance, continuing the media story mentioned 

above, includes the picture displayed in Figure 30 of a woman engaging in domestic work: 

-  
46 

 

 

 

 

 

 

 

 

 

 

2.4.3 Multimedia 
Multimedia comprise a wide variety of media products, from TV news broadcasts and documentaries to 

podcasts and video explainers for online distribution channels. Well-produced and carefully scripted 

multimedia products with human-interest elements can convey data stories more efficiently, and are 

often more engaging, with potential for wider reach with certain demographics and distribution channels.  

A multimedia story includes one or more of these key elements47:  

- Audio aid: Common types of audible aids are the spoken word, recognizable sound effects and 

music.  

- Visual aid: The most frequently used visual aids are icons, pictures, cartoons/illustrations, 

graphics, maps, and printed words and moving images.  

- Interactive aid48:  Interactions that allow the user to engage with information, audio or visual 

elements, including through augmented or virtual reality.  

 
46 https://www.dw.com/en/women-work-for-free-while-billionaires-accumulate-wealth/a-52045840  
47 https://www.planning.org/pas/reports/report150.htm 
48 For examples of interactives visit: 
https://interactive.unwomen.org/multimedia/infostory/justicenow/en/index.html 

Figure 11: Example of using real image in news articles, entitled ‘Women Work for Free While 
Billionaires Accumulate Wealth’, published in Deutsche Welle 2020 

https://www.dw.com/en/women-work-for-free-while-billionaires-accumulate-wealth/a-52045840
https://www.planning.org/pas/reports/report150.htm
https://interactive.unwomen.org/multimedia/infostory/justicenow/en/index.html
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Some essential tips to produce an effective audiovisual gender data story include49:  

- Start with a goal or purpose for preparing the audiovisual story, followed by a story outline. 

- Choose an appropriate format to reach your target audience. 

- Tell a human story or answer a question.  

o If a human-interest story, it should be about the real world and not abstract ideas. For 

instance, a story on violence against women could include a story of a community of 

women that fought for justice50 in the highest court of their country, paired with relevant 

data to provide more context. Making messages relevant for the audience is key to 

catching their attention.  

o If answering a question, in the form of an explainer video or podcast for instance, make 

sure you are answering one key question with your argument clearly, logically and 

succinctly laid out for the level of awareness of your audience on the topic.  

- Invite reliable experts and authorities to speak up on issues to increase the seriousness and 

reliability of the data story. For instance, for a story on the severity of climate change issues, 

having a scientist speak up is best suited to capture the viewer’s or listener’s attention.  

- Add illustrations to support statements and graphically depict and enhance key points.  

- Condense and simplify statistical material for context and support of the overarching narrative. 

- Data stories should not perpetuate gender stereotypes and stigmas. 

- Data stories should portray women in empowered roles.  

- Stories should always explicitly get consent from any individual to be filmed, recorded or written 

about. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
49 For more information on good practices around digital storytelling on gender, see 
http://catalogue.safaids.net/sites/default/files/publications/Enhanching-good-practice-documentation-with-
Digital-StoryTelling-SAfAIDS-Oxfam-Canada-WomensNet.pdf 
50 See an example here: https://www.unwomen.org/en/news/stories/2018/10/feature-sepur-zarco-case 

Starts with 

simple 

message 

Figure 12: Example of explainer video story entitled ‘What people miss about the gender wage gap’, Vox 2016 

https://www.unwomen.org/en/news/stories/2018/10/feature-sepur-zarco-case
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51 

 

 

2.4.3.1. Elements of multimedia stories 
 

When producing a multimedia piece, choose media components and information design elements that 
best support your narrative structure and key messaging against your timeline to execute and budgets. 
Choosing audio only, animation, documentary-style footage, or any other form of multimedia would 
depend on the story being told, the distribution platform and the financial limitations. Carefully selecting 

 
51 https://www.youtube.com/watch?v=13XU4fMlN3w  
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information design elements, such as typography and iconography, can help enhance the information 
points being conveyed.  

Some general recommendations for creating effective visual stories to communicate gender data are52: 

- Animation and illustration can be effective in providing clarity on a key message in instances 
when images or video can’t tell that story accurately or in a gender-sensitive way.  

- Use authentic footage (including authentic illustrations and photography) to support your 

narrative. Avoid the use of stock photography and footage that might be cliché. 

- When producing an interactive multimedia product, add meaningful interactions, such as play and 

pause buttons, slideshows or audio clips to support your overall data story. This will help keep 

your users engaged and may convey the message more effectively. 

- Not all multimedia pieces need to have everything. Remember your target audience. Sometimes 

a podcast with sound effects can be just as effective. 

- Information design elements, titles, iconography and typography can capture a reader’s attention 

when you want to emphasize a particular information point. In Figure 32, this has been done by 

using a different colour.  

 

 

 

 

 

 

 

 

 

  

 

 
52 https://www.hardiegrant.com/au/media/blog/the-power-of-effective-visual-storytelling  

Figure 14: Example of data driven audio-visual media story, entitled ‘Violence against 
women: Strengthening the health system response, published on YouTube, by WHO 2016 

Figure 13: Example of typography in audio-visual media story, entitled ‘One Story Too 
Many’, published on YouTube, by UN Women 2019 

https://www.hardiegrant.com/au/media/blog/the-power-of-effective-visual-storytelling


41 
 

 

 

- Build a story line through the duration of the multimedia product. Figure 34 shows snapshots of 

the WHO campaign, “Violence against women: Strengthening the health system response”53. It 

aims to highlight the prevalence of the issue as well as what women can do to seek help. The 

audiovisual depicts the whole process, from occurrence of violence to help services and healthy 

delivery.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
53 World Health Organization, YouTube. See: https://www.youtube.com/watch?v=Qc_GHITvTmI 

Figure 15: Communicating gender data on violence against women via audio-visual media, 

entitled ‘ Violence against women: Strengthening the health system response, WHO 2016 

 

https://www.youtube.com/watch?v=Qc_GHITvTmI
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2.4.5. Social media 
Social media can be defined as web-based services or platforms that allow users to create profiles and 

convey messages through social network sites54. One of the key characteristics of social media is its focus 

on communication, community-based input, interaction, content-sharing and collaboration55. Social 

media has transformed the landscape of how information is shared and communicated globally as well as 

the relationship between citizens and governments. It is a powerful tool for communicating gender-

related information across the globe. A distinct feature of social media compared to other forms of 

communication is that it generates user engagement and community dialogue, as opposed to 

communication only flowing unilaterally.   

 

Because social media is a free-flowing exchange of information and dialogue driven by individuals, content 

is consumed and interacted with at a much faster pace. Content consumption and user behaviour on 

social media can vary depending on the type of social media post or activity, user demographics (age, 

literacy level) as well as time and day of the week/month/year. Thus, social media content must be:  

1. Concise, easy to understand and must not pack in too many different data points at once.  

2. Attention-grabbing. Hook the user in with a compelling, meaningful and punchy message. Pair 

that with powerful imagery or visuals. 

3. Authentic. Where you can, link to human stories or current affairs, and always be true to your 

own voice and brand message.  

4. Jargon-free. 

5. Non-sensationalist nor misleading. 

 

To prepare communication products for distribution through social media, you should:  

 

- Create relevant (e.g. connected to current affairs or trending topics) and shareable materials. 

- Craft your message to suit the target audience’s interests and knowledge-level of the topic. 

- Make sure gender data takes centre-stage. Unlike other forms of stories, in social media there is 

no space for large amounts of information. You have to get to your point fast. Thus, place your 

most compelling or convincing gender data to support your key message at the centre of the 

information product. 

- Ensure your story is accurate. 

- Ensure your story is culturally sensitive. 

 

Below are some examples of social media posts that utilize gender data: 

 

 

 

 

 

 

 
54 https://pdfs.semanticscholar.org/deef/a708c1c1ab68528256184e0a73c48cab12c2.pdf 
55 https://whatis.techtarget.com/definition/social-media 

https://pdfs.semanticscholar.org/deef/a708c1c1ab68528256184e0a73c48cab12c2.pdf
https://whatis.techtarget.com/definition/social-media
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2.4.6. Visualizing data for social media  
 

When using social media to communicate data, consider the following recommendations for the inclusion 

of visuals: 

- Format design size: For social media posts, be mindful of the size requirements and limitations for 

each platform. This will prevent the visual from appearing blurred, shrunken or stretched. Some 

of the recommended sizes include the following (however, always check against the latest 

guidelines on social media platforms, in case of changes56):  

o Instagram: 1080x1080 px 

o Facebook: 1200x630 px 

o Twitter: 1024x512 px 

- Social media assets should be designed so that they are legible across difference screen sizes: 

Audiences could be viewing social media posts from phones, laptops, desktops or tablets. 

Therefore, text should be legible across different screens. Generally, the font size should not go 

below 18 points for online graphics57 and the graphic elements should not pack in too many 

details. 

- Social videos should include closed captioning. i.e. assume the sound is off as people are scrolling.  

 
56 See: https://makeawebsitehub.com/social-media-image-sizes-cheat-sheet/ 
57 UN Women, Visual Communication Guidelines 
https://unwomen.sharepoint.com/management/LF/Repository/Visual%20Communication%20Guidelines.pdf 

Figure 16: UN Women, Twitter 2019 
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- Size icons proportionately: When resizing, maintain the same proportions. This will keep the icons 

proportional to the data they are intended to represent and will prevent them from stretching or 

deforming.  

 

 

 

 

 

 

 

 

 

 

2.4.7. Data journalism 
 

Data journalism encompasses the entire process of deriving meaning from data to develop a story58. The 

process involves writing articles based on extracting useful information from data and embedding 

visualizations to illustrate the significance of the story59. It can be understood as a form of journalism that 

actively looks for data and analysis to inform storytelling. Thus, data journalism goes beyond simply 

including data points or infographics in news stories, but rather focuses on crafting stories around data 

findings. For instance, data journalism can be concerned with finding patterns in data, discovering trends, 

interpolating history, making predictions, detecting outliers or spotting anomalous findings. In this sense, 

it can be understood as explanatory news. Both patterns and anomalies are a good basis for crafting news 

stories. 

 

The following recommendations can be used to prepare a data journalism story:  

- The starting point should be data findings, not a story idea. It is important to let the data reveal 

the story and build the narrative around that.  

- Microdata and Big Data can provide more depth to data journalism stories, as they allow for more 

sophisticated analysis. 

- You can draw data from existing reputable sources (e.g. surveys or Big Data records) or create 

your own data set based on observations. 

- From the data, try to identify patterns or anomalies. Alternatively, you can use the data to identify 

trends or do forecasting through modelling. 

 
58 See: https://institute.aljazeera.net/sites/default/files/2019/Data20Journalism%20En%20Web.pdf 
59 Kalatzi, O., Veglis, A. & Brastas, C. 2018. The Principles, Features and Techniques of Data Journalism. 
https://www.researchgate.net/publication/327726974_The_Principles_Features_and_Techniques_of_Data_Journ
alism 

Figure 17: Resizing icons to maintain proportion 

https://www.researchgate.net/publication/327726974_The_Principles_Features_and_Techniques_of_Data_Journalism
https://www.researchgate.net/publication/327726974_The_Principles_Features_and_Techniques_of_Data_Journalism
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- Use the findings of your analysis to craft your data story. 

- Let the data story focus on the findings, although you should also explain the process of arriving 

at such findings in your news story. 

- Data journalism stories are not technical papers. They should explain the findings of analysis, and 

can mention the overall analytical process, but they should do this in a way that is understandable 

by non-expert audiences.  

- Formulas and specific details about data modelling are not well-suited for inclusion in data 

journalism stories. However, make sure you include explanations around any potential caveats 

associated with the data used or the analytical process.  

- Importantly, when writing the story, keep a clear narrative and key message and walk the 

audience through the logical argument that is being made. 

 

Remember that data journalism is a process that stems from a data set and culminates with a story, 

whether it is written or visual.  

 

 

 
 

The figure below includes an excerpt of data analysis results utilized to build a data journalism story60 

about testing the claim that more celebrity deaths were reported by the BBC in 2016.  

 

 
60 See Medium: https://medium.com/@jasoncrease/was-2016-especially-dangerous-for-celebrities-79d79b9fae02 

Figure 18: The data journalism process, Mio-Lorentz 2010 

https://medium.com/@jasoncrease/was-2016-especially-dangerous-for-celebrities-79d79b9fae02
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3. Visual communication of data  
All forms of media mentioned in the previous section can benefit from utilizing visual elements to 

communicate gender data more effectively. Visual communication is communication through graphs, 

charts, icons, photographs, slides, films or other forms of visual elements. Adding relevant graphics to 

media can be a powerful way to engage audiences. This is because the power of visual information is 

immense: 50 per cent of our brain is involved in visual processing and it only takes us 1/10th of a second 

to get a sense of a visual scene61. In a time where there is information overload, presenting information 

visually is a great way to get audiences’ attention and communicate more information in less time.  

While there are many visual elements that can be added to communication materials, the focus of this 

Module is on data visualizations, which often take the shape of graphs or infographics. Note, however, 

that although representing data visually is an effective way of conveying the message in a quick and 

simplified manner, not every visual is a good visual. For instance, graphs with truncated axes, non-

proportional depictions or non-related variables can contribute to misinterpretation, rather than aiding 

communication. Some examples of elements to include and avoid in visual communications will be given 

in this section. 

The most commonly used elements in data visualizations for communication products include:  

- Graphs 

- Maps 

- Typography 

- Iconography 

 
61 Jaya Jiwatram. Workshop on communicating gender data: promoting better use and delivering impactful 
messages. 13th June 2019. https://www.unescap.org/events/workshop-communicating-gender-data-promoting-
better-use-and-delivering-impactful-messages 
 

Figure 38: Example of data journalism story, Medium 2017 

https://www.unescap.org/events/workshop-communicating-gender-data-promoting-better-use-and-delivering-impactful-messages
https://www.unescap.org/events/workshop-communicating-gender-data-promoting-better-use-and-delivering-impactful-messages
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While written and audiovisual media often include one or several of these elements, social media often 

utilizes infographics, which typically combine several of these elements at once.  

 

3.1. Building blocks of data visualization: Graphs  
 

A graph or chart is a representation of data using items such as bars in a bar chart, lines in a line chart, or 

slices in a pie chart. A chart must represent numeric data, functions or some kind of qualitative structure.62 

Before building a chart or graph it is important to understand what the key elements are. Throughout this 

section, we will walk through these elements and provide guidance on how to construct graphs utilizing 

Microsoft Excel.  

These elements include: 

 
62 Jensen, C & Anderson, L. (1992). Harvard graphics 3: the complete reference. McGraw-Hill Osborne 
Media; 2nd ed. edition.  

 

1. Clarity and simplicity 

- What do you want the reader to know? The data visual must be simple to understand and must focus on 

conveying the message clearly 

- Focus on maximizing the impact and minimizing the noise 

- If an element does not add any value to the visual, get rid of it  

  

2. Narrative  

- Data without context is incomplete and may even be meaningless, not to mention misleading 

- Find the story around the data so the relevance is clear and it is relatable to the audience  

 

3. Design and function  

- Striking a balance between the visual design and practical utility of the visual element is key 

- It is ideal if your visual is well designed and also functions as an asset to amplify/illustrate the story 

Box 4: Key principles of data visualization 
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- Axes: These are called Cartesian coordinates, where each point on the graph is defined by two 

numbers: Category X Axis (the horizontal line) and Category Y Axis (the vertical line)63. 

Changes to the Axes are possible using Excel’s Format option (e.g. if the designer wants to 

change the highest value displayed in the axis). To do this, right-click on the axis you wish to 

edit, and select “Format”.  

  

- Axis title: This is the text that appears right next to the Axes. It is important to describe the 

chart axes so the reader knows exactly what is being measured and what is the scale of 

measurement. To edit axis titles in Excel, directly double-click on them.  

 

- Chart title: The title of the graph must provide an accurate description of the information in 

the graph, leaving no room for interpretation. The choice of chart title may depend on the 

purpose of the communication material. In a statistical report, the title could be the exact 

indicator name, followed by disaggregation type (where relevant), reference year for the 

data, units of measure and reference period. (e.g. Proportion of women ages 20–24 in a union 

before age 18, percentage, 2014). However, for a media product, it might be more relevant 

to add a catchier title (e.g. ‘Bangladesh has the highest proportion of child brides in South and 

South-Eastern Asia’). To edit a chart title in Excel, simply double-click on it.   

 

- Data labels: These are labels that help the reader understand the exact value of the data 

points. The location and the format of the data labels can be changed in Excel by right-clicking 

on the chart’s data points.  

 

 
63 http://indiana.edu/~p1013447/dictionary/graph_d.htm  
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Figure 39: Sample graph showing key elements  
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- Legend: Legends are typically used for categorical variables. They describe the names of each 

of the categories. To edit the text in a legend, go to the Excel table with the data, and manually 

change the names of the relevant rows or columns. The changes should update on the graph. 

Please note that one of the most important steps in creating an effective data visualization is selecting the 

right type of chart to showcase your data. Your selection should be informed by whether you are looking 

to present the distribution, relationship, composition or comparisons in your data64. 

Figure 40: How to choose your charts, iDashboards, 2020 

 

 
64file:///C:/Users/sara.duerto.valero/Desktop/FPI/Nepal/Genderizing%20Census/How%20to%20choose%20your%
20charts.pdf 

file:///C:/Users/sara.duerto.valero/Desktop/FPI/Nepal/Genderizing%20Census/How%20to%20choose%20your%20charts.pdf
file:///C:/Users/sara.duerto.valero/Desktop/FPI/Nepal/Genderizing%20Census/How%20to%20choose%20your%20charts.pdf
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3.1.2. Bar and column charts 
Bar or column charts present categorical data with rectangular bars that have dimensions proportional to 

their values. For instance, a bar showing 16 per cent will be shorter in length or height than a bar showing 

30 per cent.  

Recommendations for crafting a bar chart that communicates data effectively include:  

- Organize the bars from smallest to largest or vice versa, to allow readers to draw quick 

comparisons and conclusions.  

- If the emphasis of the communication message is on the gap between different categories (e.g. 

women vs men), then order the data points by length of gap instead of total value.  

- Always include clear information on the indicator name, geographical area, year, measure and 

any other details that might allow the reader to interpret the data effectively. Depending on the 

type of communication material that will be hosting this visualization, this information might be 

included as a graph title (e.g. if the graph is to appear in a statistical report) or as a footnote (e.g. 

in a newspaper article, the title should be catchier, but the information is still essential to convey). 

- Remember to include axis titles if this information is not obvious to the reader just from the title 

of the graph. 

- Include labels in each bar to ensure the information is conveyed accurately. 

- Do not truncate the axis, particularly if you are displaying two similar graphs side-by-side, as this 

might be misleading. Typically, it is best to avoid truncating the bottom of the axis in all instances. 

When displaying percentages, it is recommended to show values from 0 to 100 only. 

 
Exercise 1: Using the data in Table 1, create a bar graph using all the appropriate graph elements. 

 
Table 1: Data for proportion of women aged 20–24 years who were married or in a union before age 18 

Country Value (in %) 

Afghanistan 34.8 

Bangladesh 58.6 

Bhutan 25.8 

Cambodia 18.5 

India 27.3 

Indonesia 11.2 

Iran (Islamic Republic of) 16.7 

Lao People’s Democratic Republic 32.7 

Maldives 3.9 

Myanmar 16 

Nepal 39.5 

Pakistan 21 

Philippines 16.5 

Sri Lanka 9.8 

Thailand 22.5 

Timor-Leste 14.9 

Viet Nam 10.6 
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Solution:  

The data in Table 1 contains information on child marriage across countries in Southern and South-Eastern 

Asia.  

To create a simple bar chart for this table in Excel: 

1. Go to Excel and open the file attached to this module 

2. Select the data with your mouse 

3. Select Insert from the menu bar 

4. Select Chart 

5. Select Bar chart  

The following chart will appear as a result:   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Decide what the purpose of this graph is. Is your intention to highlight which country has the 

highest and lowest proportions? If so, rank the countries by percentage of child marriage by: 

o Selecting the full range of data in Excel 

o Selecting “Data” from the upper menu bar 

o Selecting “Sort”  

A new dialogue box will open as follows: 
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Figure 19: Preliminary chart showing results without ranking 
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7. Select to sort the data by value, and whether you prefer smallest to largest or the other way 

around. This selection will rearrange the bars accordingly. 
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Figure 43: Preliminary chart showing results with ranking from smallest to largest value 

Figure 42: Dialogue box for data ranking 
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This display of data is more organized and conveys the message more efficiently. However, this graph is 

still incomplete. If presented before a lay person, it is unlikely they would fully understand what it means. 

In order to complete the graph, add a title, data labels and axis titles, as well as any other elements as 

needed. You can do so by selecting the outer frame of the bar, and clicking on the “+” sign that appears 

to the right. Alternatively, you could go to “Chart design options” on the top-left corner of your Excel 

sheet. 

 

 

 

 

 

 

 

3.1.2. Line charts  

Line charts are useful for visualizing continuous variables, such as time series (series of data showcasing 

trends over time). For instance, the data in Table 2 show the median age of women at first marriage for 

three different years. The data show that the median age at first marriage has increased over time.  
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Figure 44: Final graph with supporting chart elements  
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Exercise 2: Using the data in Table 2, create a line chart and add all the appropriate chart elements.  

Table 2: Median age at first marriage 

 

 

 

 

 

Solution:  

To depict this using a line chart, follow these steps: 

1. Select the data with your mouse 

2. Go to Insert>Chart>Line chart 

3. Format the data adding all relevant elements (chart title, axis labels, data labels, etc.)  

4. You should obtain a graph as follows:  

 

 

 

 

 

 

 

 

 

 

 

 

Year Residence 

Urban Rural 

2007 15.8 14.8 

2011 16.2 15.3 

2014 16.6 15.6 

Figure 45: Median age at first marriage for women in Bangladesh 
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Notice the Y axis is truncated. The axis in the graph above begins at 10 instead of 0. To avoid conveying 

misleading messages, particularly when comparting two graphs side by side, it is recommended to always 

depict graphs with Y axis values starting at 0. Otherwise, as shown below, gaps might appear bigger than 

they actually are. Both graphs in Figure 46 display the same data.  

 

3.1.3. Pie chart 
These are commonly used to showcase the parts of a total. It is important that all the slices of a pie chart 

add up to 100 per cent. For instance, the data set in Table 3 shows the average daily time women spend 

doing different activities in Pakistan.  

 

Exercise 3: Using the data given in Table 3 below, create a pie chart and add all the appropriate chart 

elements. 

Table 3: Time spent on unpaid care and domestic work 

 

 

 

 

 

 

 

Activities Average daily time 
spent (in hours) 

Unpaid care work 0.91 

Unpaid domestic 
work 

4.57 

Other activities 19.24 
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Figure 46: Comparison between graphs with varying primary vertical axis values 
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Solution:  

To represent this information visually on a pie chart, follow these steps:  

1. Select your data with your mouse 

2. Select Insert>chart>2D Pie Chart  

The result will look as follows:  

 

 

 

 

 

 

 

 

 

 

 

 

 

Since the slices of the Pie shown in Figure 45 do not add up to 100 (19.24+0.91+4.57=24), it would be 

difficult for a reader to interpret this visualization. Instead, the values (given in hours) should be converted 

into percentages so that they add up to 100.  

These values can now be presented as a pie chart, as shown in Figure 48: 

 

0.91

4.57

19.24

Average daily time spent on different activities by women in Pakistan

Unpaid care work Unpaid domestic work Other activities

Figure47: Time spent on activities by women in Pakistan 
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3.1.4. Scatter plots  

These are commonly used to visualize associations between variables. When two variables are plotted in 

a scatterplot, a cloud of dots represents each of the data points. The more the dots seem to cluster around 

a line, the higher the association between the variables. Please note that not any two variables can be 

compared on a scatter plot. Scatter plots are better suited for continuous (non-categorical) variables when 

a relation between the two variables is suspected.  

Exercise 4: Using the example data set attached to this module, create a scatterplot graph and add all the 

appropriate chart elements. Additionally, add a trendline to visualize the association between the two 

variables.  

Solution:  

To create a scatter plot using Excel, please refer to the example data set attached to this module and 

follow the following steps: 

1. Open the Excel worksheet  

2. Select the Insert>Chart>Scatterplot  

3. Add Axis titles, chart titles and other necessary elements. 

 

3.82%

16.04%

80.14%

Average daily time spent on different activities by women in Pakistan

Unpaid care work Unpaid domestic work Other activities

Figure 48: Time spent on different activities by women in Pakistan 
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Add a trendline by right-clicking on the dot cloud and selecting “add trendline”. The resulting graph should 

look as follows:  

 

 

3.1.5. Box and whisker or boxplots 
A box and whisker plot – also called a box plot – is a graph better-suited for advanced or technical users, 

that displays a five-number summary of each of the categories of a set of data (minimum, first quartile, 

median, third quartile, maximum). For instance, a box plot could be useful to summarize the following 

data set with observations about women’s total number of years of education:  

Table 4: Women's total years of education in Timor-Leste (DHS 2017), Philippines (DHS 2013) and 
Bangladesh (DHS 2014) 

Respondent 
ID 

Timor-Leste Philippines  Bangladesh 

1 6 14 5 

2 11 0 1 

3 17 15 3 

4 10 7 8 

5 16 8 0 

6 16 10 0 

7 12 15 4 

8 10 6 5 

9 12 7 5 

10 9 7 4 

0
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Figure49: BMI increases as age at first marriage increases 
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Any data set that includes numerous observations that could be grouped across categories (e.g. many 

observations per country, many countries per region, etc.) is well-suited for depiction through box plots. 

If there are large variations between the values under each of the categories, the boxplots are particularly 

useful to show outliers and the skewed nature of the distribution. 

For the values in Table 5, the five-number summary for each of the countries will be: 

Table 5: Five number summary for box and whisker chart 

 

In a box plot, we draw a box from the first quartile to the third quartile. A horizontal line goes through 

the box at the median. Box plots can also show outlier values in distributions, which are useful to depict 

countries or individuals whose behavior differs from the bulk of the population.  

Exercise 5: Using the example data set attached to this module, create a box and whisker chart and add 

all the appropriate chart elements.  

Solution:  

Using the Excel data file attached to this module (and pictured above), follow these steps to create a box 

plot: 

 

1. Open the Excel data file, sheet 5 

2. Select the data with your mouse 

3. Select Insert>chart>box and whisker from the 

menu bar 

4. Add the appropriate Chart Elements to obtain 

a graph as follows: 

 

Five number 
summary 

Formula in Excel Timor-Leste Philippines Bangladesh 

1. Minimum  =Min (range of data) 6 0 0 

2. 1st Quartile =Quartile (range of 
data, 1) 11.5 7.5 4 

3. Median =Median (range of 
data) 11.5 7.5 4 

4. 3rd Quartile = Quartile (range of 
data, 3) 15 13 5 

5. Maximum =Max (range of 
data) 17 15 8 
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Excel will calculate the five values automatically, so the graph provides a very quick summary of the 

distribution of values across each of the categories (countries in this example). 

3.1.6. Radar charts 
These are commonly used to plot three or more indicators at once, in a way that it is easy for the reader 

to compare information across indicators and population groups.  

For instance, Table 6 displays values for three indicators for the poorest and richest women in Timor-

Leste. The indicators are:  

- Child marriage: The proportion of women (ages 18–49) who were married before the age of 

18.  

- Unclean cooking fuel: The proportion of women and girls (aged 15–49 years) who have 

primary reliance on unclean cooking fuel.  

- Overcrowding: The proportion of women and girls (aged 15–49 years) who live in 

overcrowded households.  

- Table 6: Data on three SDG-related outcome areas 

Indicators Poorest Richest 

Child marriage 30.77 15.39 

Unclean cooking 
fuel 

99.73 68.19 

Overcrowding 48.52 20.31 

 

Figure 50: Distribution of women’s education in Timor-Leste, Philippines and Bangladesh 
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Exercise 6: Using the data given in Table 6, create a radar chart and add all the appropriate chart elements 

 

Solution:  

To create a radar chart to represent this dataset visual: 

1. Open Sheet 6 on the Excel file accompanying this module 

2. Select the entire range of data with your mouse 

3. Go to Insert>Charts>Radar  

4. Add various elements by clicking on the “+” sign (a chart title, a legend) 

5. Change the colors and the types of data lines by right clicking on them and selecting “format”. 

The output chart should look as the one displayed in Figure 5165. This graph shows that the most 

problematic area (out of the three) in Timor-Leste is the use of unclean cooking fuel. Nearly all poor 

women use them, compared to 68 per cent of the richest women. The graph also shows that poor women 

are more likely to be worse-off across all three indicators, compared to rich women. Thus, these graphs 

are useful to identify population groups that are lagging behind.   

 

 

 
65 Values in the figure have been rounded off 
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Figure 51: Proportion of women facing deprivation across three indicators  
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3.2. Building blocks of data visualization: Maps  
 

Maps are visual representations of data that are typically used when there are geographical regions in the 

data, like countries/regions, states, counties or postal codes. However, not all maps necessarily have a 

geographical component. Maps can be used to compare values and show categories across geographical 

regions66 or hierarchical elements. Many kinds of maps exist, including:67 

- Heat maps: Maps that represent the intensity of an incident’s occurrence within a data set, 

typically by utilizing different shades of the same color. Heat maps may or may not have a 

geographical component (e.g. if a geographical map is shaded in different intensities of the 

same color, this may be a geographical heat map – or a choropleth – but a table can also be 

shaded, in which case this may not be geographical). 

- Proportional symbol maps: Maps that represent data tied to a specific geographical point or 

data that is aggregated to a point to form a wider idea. Representation is made with circles 

or other symbols that are proportional to the data point. 

- Dot intensity maps: Maps where a dot represents a feature or an attribute in the data. For 

instance, each dot may represent a single occurrence of an incident tied to a particular 

location, or a set of occurrences (e.g. a dot may represent 100 occurrences in that particular 

location).  

- Tree maps: graphical representations of hierarchical data. Although they are called maps, no 

geographical component is necessary.  

 Although there are multiple kinds of maps, in this module the focus will be on maps that can be created 

using Excel: tree maps and heat maps only. If you wish to build a choropleth (or a geographical map with 

color coding), this can only be achieved with Excel if an Add-on is installed68.  

 

3.2.1. Tree maps  
Tree maps are commonly used to display hierarchical data. Each category is represented as a rectangle 

and subcategories are displayed as smaller rectangles with the same color. For instance, the data set in 

Table 7 shows the proportion of women who were attended by a doctor vs. a traditional attendant at the 

time of delivery, in India. The data has been disaggregated by Location (urban and rural) and Wealth 

(poorest and richest households). To create a tree map, it is important that data is arranged in a 

hierarchical manner, i.e. the top row is the overarching group (e.g. Doctor), followed by subgroups (e.g. 

location and wealth), followed by further grouping (e.g. Urban, Rural, Poorest and Richest). This can be 

seen in Table 7:  

Table 7: Data on proportion of women who were attended by a doctor or traditional health professional 

Doctor Traditional attendant 

Location Wealth  Location  Wealth  

 
66 https://support.office.com/en-us/article/create-a-map-chart-in-Excel-f2cfed55-d622-42cd-8ec9-ec8a358b593b  
67 See: https://carto.com/blog/popular-thematic-map-types-techniques-spatial-data/ 
68 Go to Insert>Store>Add-in>Geographic Heat Map.  

https://support.office.com/en-us/article/create-a-map-chart-in-excel-f2cfed55-d622-42cd-8ec9-ec8a358b593b
https://carto.com/blog/popular-thematic-map-types-techniques-spatial-data/
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Urban  Rural Poorest Richest  Urban  Rural Poorest Richest  

72.8 49.5 32.4 80.7 5.9 12.9 21 2.4 

 

Exercise 7: Using the example data set given in Table 7, create a tree map and add all the appropriate 

chart elements 

 

Solution:  

To visualize this data as a tree map,  

1. Use Sheet 7 of the Excel data set that accompanies this Module 

2. Select Insert>Chart>Tree map from the menu bar 

3. After adding the chart title, you will have a tree map as follows: 

 

 

 

 

This tree map shows that more women were attended by a doctor at the time of their delivery than by a 

traditional practitioner. It also shows that the bulk of women attended by a doctor live in rich and urban 

households, while the majority of women attended by traditional attendants live in poor rural households.  

Figure 52: Tree map showing proportion of women who were attended by doctor or traditional 
attendant, by wealth and location 



64 
 

 

3.2.1. Heat maps using conditional formatting 

Heat maps are commonly used to visualize data using a colour scale. Let’s look at the following example 

to understand the steps involved in creating a heat map:  

The data set in Table 8 shows data for seven indicators in Mongolia, Maldives and Bangladesh: 

Table 8: Data on multiples SDG-related outcome areas 
 

Proportion of women deprived in these areas 

Indicator Mongolia Maldives Bangladesh  

Primary or less education 8.19 13.55 60.99 

Child marriage 6.22 19.14 75.23 

Inadequate drinking 
water 

33.99 0.16 5.35 

Inadequate sanitation 14.23 1.4 50.04 

Currently not employed 38.76 54.99 65.85 

Do not use clean cooking 
fuels 

52.01 0.56 82.29 

Overcrowding 46.91 33.36 39.44 

 

Exercise 8: Using the example data set given in Table 8, create a heat map and add all the appropriate 

chart elements 

Solution:  

To visualize this information: 

1. Open this data set in Excel 

2. Select the range of the table 

3. Select ‘Conditional Formatting’ on the menu bar and the Red-White colour scale will assign the 

darkest shade of red to the highest value and white to the lowest value. 

 

 

 

 

- From the drop-down options, select ‘Color Scale’ (Red-White colour scale) 

 

4. Select part of the table which contains numbers  

5. Right click 

6. Select the Format Cell option 

7. A new dialogue box will appear; select the “Custom” option 

Figure53: Conditional formatting option on menu bar 
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8. Delete the word General (by clicking the Backspace key on the keyboard) 

9. Type ;;; (3 semicolons)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This command will delete the figures in the table, returning the following graph: 

 

Figure 55: Heat map for proportion of women deprived in select SDG-related areas, select countries, 2013–
2017 

 Proportion of women deprived in these areas  

SDG-related indicators Mongolia Maldives Bangladesh  

Primary or less education     
Child marriage     
Inadequate drinking water    

Inadequate sanitation    

Currently not employed     
No clean cooking fuel    

Overcrowding     
 

The table shows that the darkest shades of red are clustered in the column for Bangladesh, indicating that 

women in Bangladesh are more deprived than those in Mongolia and Maldives across most indicators. 

Figure 54: Custom format cell dialogue box 
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Similarly, the table indicates that the issue of overcrowding is quite worrisome across countries, while the 

issue of inadequate drinking water is only of concern in Mongolia.  

3.2.3. Heat maps 
 

Heat maps (sometimes also called choropleths) can be used to depict data in instances where 

geographical distribution matters to the data story. The example below shows international estimates for 

maternal mortality ratio by year between 1990–2005. Colour scale is used to categorize values of maternal 

mortality ratio. The darker the shade of blue, higher the maternal mortality ratio in that country. 

 

 

 

 

If you wish to build a choropleth (or a geographical map with colour coding), depending on the version of 

the software that you are using, it is possible you might need to install a map Add-on69. Once this is done, 

creating choropleths with Excel requires the following steps: 

 

 
69 Go to Insert>Store>Add-in>Geographic Heat Map.  

Figure 56: Example heat map, UN Women Data Hub 
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Table 9: Data on prevalence of intimate partner violence against women in the last 12 months 

Country Percentage of women 15–49 years who 
experienced intimate partner violence 
in the last 12 months (DHS data) 

Afghanistan 45.8 

Bangladesh 17.3 

Cambodia 9.3 

India 20.6 

Pakistan 13.6 

Philippines 4.4 

Timor-Leste 33.1 

 

To visualize this information in the form of heat maps: 

1. Open this data set in Excel, utilize Sheet 8 

2. Select the range of the table with your mouse 

3. Select the insert>chart>map 

4. Add the chart title and other chart elements until the output looks as depicted in Figure 57 

 

 

 

 

 

 

 

 

 

 

 

 

 

This heat map shows the darkest shade of blue for Afghanistan, indicating that the prevalence of intimate 

partner violence in the last 12 months, for year 2015 is higher than in the other countries with available 

data.  

 

Figure 57: Prevalence of intimate partner violence among women aged 15-49 
years 
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3.3. Building blocks of data visualization: Typography  
Typography not only enhances design, but is a commonly used technique in design to arrange text to grab 

a reader’s attention and for information hierarchy, meaning the categorization of text according to its 

importance. Different font types and sizes can be used to differentiate the text that is most important. 

Typically, larger font sizes are used to reveal shocking figures or to single out one data point. Take the 

example in Figure 58: 

  

70 

 

 

 

By enlarging the ‘67%’ and typing out the key message, typography can be a visual hook to catch readers’ 

attention. The use of typography as a visual communication component is particularly useful for 

communication tools such as infographics, where a number of visual elements, data and text are 

combined. It is important to note, however, that scientific and technical messages are not suited for 

display through typography visualization. For instance, although the full indicator name here would be 

“Proportion of seats in the UN Framework Convention on Climate Change, the Kyoto Protocol and the 

Paris Agreement, that are occupied by women”, the language has been simplified to appeal to wider 

audiences. 

When working with typography in infographics or other forms of visual communication products, it is 

important to utilize a consistent visual identity, with the same type of font and colour palette used 

throughout the product. Despite the larger font size, the typography element must look like it belongs to 

the overall communication product, so consistency is particularly important.  

 
70 UN Women Social Media, Women’s rights in Review 25 Years After Beijing, June 2020 

Figure 58: Example of Typography, UN Women 2020 

 

 

 

https://beijing20.unwomen.org/en
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3.4. Building blocks of data visualization: Iconography 
An icon is a pictorial symbol for a word or text. It is a great way to convey a point quickly and make 

information more engaging. However, caution must be exercised when using a symbol or icon for a word. 

To the extent possible, that icon should: 

- Exclusively stand for that word/text and not be associated with any other potential meanings to 

avoid misinterpretation.  

- Not reinforce cultural and gender bias. For example, traditionally, we may be used to associating 

being a doctor with a man and being a nurse with a woman. Your icons should not reinforce this 

bias.  

- Be culturally appropriate. For instance, we are used to depicting women with short dresses and 

men with pants. If the visualization is to be used in places where women traditionally wear long 

dresses or men wear skirts, it is important to adapt the icons accordingly. 

- Keep adequate proportions. This is particularly important when re-sizing a pictogram; do not skew 

or stretch the image. 

- Not leave people guessing. While icons are a great way to convey a message, they can just as 

easily take away from a message when their use is not clear and/or if they replace meaningful 

text or labels that would have added clarity.  

Figure 59 displays examples of icons that are culturally appropriate in many countries and contexts.71 

In order to utilize icons for communication products, you can either use one of the existing pre-designed 

graphics, such as Flaticon72 or Infogram; or create your own utilizing more sophisticated software such as 

Freehand73. In this module, information on downloading and using icons will only be provided on the basis 

of using existing files.  

 

 

 

 

 

 

 

 

 
71 Please note that these pictograms have been borrowed from Infogram, https://infogram.com/ and UN Women’s 
Icon Book, 
https://www.dropbox.com/sh/v61dj55dmaa4dbt/AABwvWaZ4CGlcnwTVroIVV9ea?dl=0&preview=UN+Women+Ic
on+Book.pdf 
72 https://www.flaticon.com/  
73 https://www.adobe.com/mena_en/products/freehand/  

https://infogram.com/
https://www.dropbox.com/sh/v61dj55dmaa4dbt/AABwvWaZ4CGlcnwTVroIVV9ea?dl=0&preview=UN+Women+Icon+Book.pdf
https://www.dropbox.com/sh/v61dj55dmaa4dbt/AABwvWaZ4CGlcnwTVroIVV9ea?dl=0&preview=UN+Women+Icon+Book.pdf
https://www.flaticon.com/
https://www.adobe.com/mena_en/products/freehand/
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3.5. Infographics  
Many of the building blocks of data visualization, such as charts and graphs are often combined with 

iconography, data and short narratives to convey messages in an effective manner. Infographics are a 

great way to achieve this. Before choosing the type of infographic you want to produce, keep in mind the 

specific dimensions and formats required by different platforms. For instance, the language you will use 

in an infographic to be published on LinkedIn will differ from that in an infographic to be published on 

Instagram. Moreover, the approach may be different, as Instagram allows the user to post multiple images 

to tell a continuous story. 

Figure 59: Infographic utilizing appropriate icons, UN Women, 2020 

Portraying women in 

culturally appropriate 

ways 

e.g. woman wearing long 

skirt and pants 

Easy to understand and 

universal iconography 

e.g. briefcase indicating 

formal work 

Women’s representation 

in all types of occupations 

e.g. women working in 

both office jobs and 

selling goods 
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Infographics are defined as graphic visual representations of data or information intended to present 

information in an engaging and concise way to tell a story or key message74. Every gender-related 

infographic must include three key elements: 

1. Gender data: This should be a key component of an infographic, as gender data in infographics is 

the vehicle to convey gender-related messages effectively. However, it is important to limit how 

many data points you include in each infographic, to avoid overwhelming the audience.  

2. Visuals: should be the central elements of an infographic. Visuals are expected to provide almost 

all information necessary. They need to be simple, straightforward and to the point. Avoid adding 

visual elements that do not convey any additional information. In addition, if the infographic is to 

be disseminated through social media, the visual elements cannot be complicated, small or 

include too many details. Users should be able to understand and scan them quickly, often 

viewing them on a mobile device, without spending time deciphering.  

3. Narrative: The key messaging of an infographic should be provided in the title and weaved 

throughout the infographic to support the overarching point. Titles must be short and not 

scientific (e.g. use catchy or easy-to-understand titles such as “3 out of 10 women are victims of 

violence”, rather than “30% of women ages 15–45 reported being victims of intimate partner 

violence in the last 12 months”). Minimize the amount of text in infographics – keep it short, 

jargon-free and to the point. Most of the information should come from the graphical elements 

and data points. In a single graphic for social media, text should ideally be reduced to the title, 

and at most one additional sentence. The full indicator titles can be added in the form of footnotes 

if these are necessary to avoid misinterpretation. For a full infographic for display on a website, 

also keep text to a minimum and don’t let the infographic go on for too long. Lay out your logical 

argument and try to keep it to three to five data points, ideally, to support your overall message. 

The following are examples of infographics that convey gender data messages effectively.75 

 
74 Smiciklas, Mark. 2012. The Power of Infographics: Using Pictures to Communicate and Connect with Your 

Audiences 
75 https://twitter.com/un_women/status/1141017755036127232  

Figure 60: Key components of an infographic 

https://books.google.com/?id=Lkf5DKSWoJsC
https://books.google.com/?id=Lkf5DKSWoJsC
https://twitter.com/un_women/status/1141017755036127232
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- Data: The data in this infographic have been scaled down to 10 girls. Instead of saying 40 per cent, 

it says 4 in 10 girls. This makes it easier for the audience to understand the severity of the situation 

better, because 10 is easier to grasp than large numbers or percentages. 

- Visual: Icons have been used to depict girls. There is a distinction between girls who are married 

with respect to the total population of girls. 

- Narrative: The approach of this infographic is to make this information relatable. The message has 

been weaved into a story about child marriage being prevalent in West and Central Africa. 

Figure 61 is an infographic depicting the duration of guaranteed paid maternity leave time in select 

countries for the year 2014.76 

- Data: The infographic depicts data on the duration of guaranteed maternity leave in various 

countries, with respect to the United States. Data have been presented in weeks instead of days 

for ease of understanding. 

- Visual: The data on countries have been presented in a donut graph (with each country given equal 

weight) as well as maps. The size of the map does not mean anything and is not proportional to 

the actual geographical area. Typography has been used to highlight key information. 

- Narrative: The focus of this infographic is to answer the question ‘How many weeks do other 

countries guarantee compared to the U.S.?’ and proceeds to compare other countries with the 

United States. 

  

 
76 https://thinkprogress.org/u-s-paid-family-leave-versus-the-rest-of-the-world-in-2-disturbing-charts-
365324eeba45/ 

Figure 61: Infographic depicting child marriage in Central Africa, UN Women 2019, Published on 
Twitter 

https://thinkprogress.org/u-s-paid-family-leave-versus-the-rest-of-the-world-in-2-disturbing-charts-365324eeba45/
https://thinkprogress.org/u-s-paid-family-leave-versus-the-rest-of-the-world-in-2-disturbing-charts-365324eeba45/
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77 

 

 

 

 

 

 

 

 

 

 

 
77 https://www.facebook.com/unwomen/photos/a.10150211048801905/10152677204501905/?type=3&theater  

Figure 62: Infographic depicting duration of guaranteed paid maternity leave, Think Progress 2014 

Figure 63: Infographic depicting several issues associated with gender-based wage gaps, UN Women 
2015, Published on Facebook 

https://www.facebook.com/unwomen/photos/a.10150211048801905/10152677204501905/?type=3&theater
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- Data: Three separate data points are conveyed in this infographic. This is a manageable number 

and it is still possible for the reader to assimilate all of them because they relate to each other 

(e.g. all of them are on the topic of employment and wages). 

- Visual: The infographic makes use of iconography and typography. Some of the more important 

data points are reflected in larger font size, which is expected to attract readers’ attention. The 

icon at the centre is not associated with data, but it is useful in that it gives the reader an 

immediate idea of the topic of the infographic. The coin icons to the right, however, are associated 

with the 30 per cent data point above, and the number of coins is proportional to the data point.  
- Narrative: The title is simple and to the point, and the statements in red are not complex but 

convey the message succinctly and accurately. A short footnote is added to avoid 

misinterpretation.  

 

3.5.1. Using design tools for data visualization  
The Adobe Creative Suite, including Illustrator, is an industry standard among designers in creating 

visualizations and infographics. While there is a learning curve to using Adobe Illustrator and other 

professional design software, there are many easy-to-learn and use third-party design tools online to 

produce data visualizations and infographics. One of the many software tools available online to support 

the production of infographics is Canva78, a popular, cost-effective, easy-to-use tool to create graphics, 

presentations, posters and other visual products. It can be used by those who have little or no experience 

in creating data visuals, although its ability to produce more complex assets is limited. 

 

Exercise 9: Using the example in Figure 64, replicate the infographic using design software. 

 

 

 

 

 

 

 

 

 

 
78 http://www.canva.com/ 

Figure 64: Example infographic: Women in politics, published through Twitter, 2016 
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Solution: 

To depict this information visually using Canva, follow these steps79:  

1. Go to Canva at: http://www.canva.com/ 

2. Log in using your email address (create an account if you don’t have ) 

3. A window showing the new library will open. It will look like this: 

 

 

 

 

 

 

4. Select “Large Rectangle Ad”. Depending on where you want to publish your infographic, your 

selection can change. For the purpose of this example, since we want to work on a blank canvas 

with a landscape format, we make this selection. Once you make this selection, a blank document 

will appear as follows: 

 

 

 

 

 

 

 

 

 

 
79 For on-line tutorials visit: https://designschool.canva.com/tutorials/ 

Figure 65: Canva library webpage 

Blank page 

Formatting 

options 

Figure 66: Blank document for building Infographic in Canva 

http://www.canva.com/
https://designschool.canva.com/tutorials/
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5. Select “Elements” from the format menu as shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. From the Shapes option, select the rectangular shape to divide the page into two rectangular 

parts (as can be seen in Figure 64 above).  

7. Adjust the dimension of the rectangle and duplicate it to have two rectangles of the same 

dimension on the same page. After doing this, the canvas should look like this: 

Figure 67: Elements option in Format menu in Canva 

Elements>Shapes 

Rectangular 

shape  
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8. Change the colours of one of the two sides utilizing the colour menu. The specific hexadecimal 

colour code for the left side is #d9d9d9 and for the right side is #393c42.  

 

Figure 68: Working canvas divided into two rectangles in Canva 

Section 1  Section 2  

Figure 69: Colour menu on Canva 
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 Once you make this selection, your canvas should look like this: 

 

 

 

 

 

 

 

 

 

 

 

9. To add icons, as shown in Figure 64, type “female leader talking”, “parliament”, “woman” and 

“man” in the search bar of the Elements menu. Note that since we want to depict current 

proportion of women in parliament (i.e. 22 per cent), you must select 8 “man” icons and 2 

“woman” icons to make sure the proportion of women is roughly 2 out of 10 (e.g. 22 per cent).  

10. Change the colours of all these icons as shown in Figure 64. After adding these icons, your canvas 

should look like this:   

 

 

 

 

 

 

 

 

 

 

 

Figure 70: New canvas after colour selection 

Figure 20: Canvas with all relevant icons 
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11.  Add all the text elements to give meaning to these icons and convey the main message. This can 

be done by selecting from the Text menu. Note that you must select the “subheading” option for 

smaller text and “heading” option for the larger text. 

 

 

 

 

 

 

 

 

 

12.  To edit the font size, font style and font colour in line with Figure 64, select the following options: 

- Font style: Montserrat Classic for subheading and Montserrat Extra Bold for key text 

- Font size: 8-point size for subheading text and 10.4 for key text  

- Font colour: Colour code #545454 and #2d9cd7 for left section; #d9d9d9 and #2d9cd7 

for the right section  

 

13. To add the data visual element (bar graph on the left side), go to the Elements option and search 

for bar chart. Add the values as shown in the figure below:  

 

 

 

 

 

 

 

14. The final infographic should then look like this: 

 

 

 

 

 

Figure 72: Text options to edit text in Canva 

Figure 213: Data table to build bar chart 
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3.6. Data visualization tools of the trade  
Many tools and software are available online to create visually appealing data visualizations and 

infographics.  While some of these tools/software are better-suited for users with little or no experience 

in data visualizations, others are for more advanced users who wish to create complex and more 

sophisticated visuals, often meeting industry standards. 

Tools for beginners: 

- Data visualization (including maps) 

o Google charts (via google sheets) 

o Infogram 

o Tableau 

- Infographics  

o Piktochart 

o Vennage 

o Canva  

Tools for advanced users: 

- Data visualization  

o Google charts  

o D3.js 

o MapBox 

o Google maps 

Figure 74: Final example infographic 
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- Infographics  

o Adobe Illustrator  

o InDesign 

o After Effects, Premiere (motion graphics) 
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4. KEY TAKEAWAYS 

- Communication between data users and data producers is important and enhances data use as 

it can align data user’s needs with data producer’s priorities for producing data. It can also help 

journalists understand data and use it to produce data-driven stories. 

- Communication between data users and data producers is needed, both before and after data 

production 

- User's level of knowledge and awareness of the topic should guide the degree of technicality of 

the data communication product. It should be more detailed and granular for data analysts and 

researchers and less detailed and more visual for users such as the general public and media.  

- While traditional databases are common channels for disseminating gender data to expert 

audiences, interactive data portals designed with non-experts in mind can help them engage 

with data and promote data use. 

- Data visualizations in statistical reports should include comprehensive information about data 

sources, caveats, reference periods and any other information to convey information accurately 

and without leaving room for interpretation.  

- Factsheets are a concise means of communicating key findings. They should be thoughtfully 

organized, having the right balance between text, visuals and overall design. Factsheets must be 

concise.  

- When producing gender data stories on social media, communicate in a clear and concise 

manner, convey empowering messages through powerful imagery and pair your data with a 

human-interest or current affairs angle.  

- For statistical graphs, remember to add all the relevant chart elements (such as title, axis title, 

data labels and data legends) to fully communicate the message. Select the type of graph that is 

best-suited to depict your data efficiently. Remember that choosing a type of graph that doesn’t 

suit your data will result in misleading messaging. 

- Infographics are visual representations of data intended to present information in an engaging 

and quick way. Use typography and icons to make them engaging for readers. A good 

infographic has the right balance between data, visual and narrative.  

- Consider the aspect ratio when producing data products for social media, as every social media 

platform has a different recommended size. 
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